Copyright Notice

Copyright © 1995-2013 Keynote Systems, Inc. All rights reserved

THE INFORMATION CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT ANY EXPRESS REPRESENTATIONS OF WARRANTIES. IN ADDITION, KEYNOTE DISCLAIMS ALL IMPLIED REPRESENTATIONS AND WARRANTIES, INCLUDING ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

All text and figures included in this publication are the exclusive property of Keynote and may not be copied, reproduced, or used in any way without the express permission in writing of Keynote. Information in this document is subject to change without notice and does not represent a commitment on the part of Keynote. Keynote may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents except as expressly provided in any written license agreement from Keynote.

The trademarks or registered trademarks of Keynote Systems, Inc. in the United States and other countries include: Keynote®, DataPulse®, CustomerScope®, Keynote Customer Experience Rankings®, Perspective®, Keynote Red Alert®, Keynote WebEffective®, The Internet Performance Authority®, MyKeynote®, SIGOS®, SITE®, keynote® The Mobile & Internet Performance Authority™, Keynote FlexUse®, Keynote DeviceAnywhere®, DeviceAnywhere®, Keynote DemoAnywhere®, Keynote MonitorAnywhere®. All related trademarks, trade names, logos, characters, design and trade dress are trademarks or registered trademarks of Keynote Systems, Inc. in the United States and other countries and may not be used without written permission. All other trademarks are the property of their respective owners.

Please forward any comments or suggestions regarding this document to Keynote Support.

Keynote Systems, Inc.
777 Mariners Island Blvd.
San Mateo, CA 94404
Contents

About This Document .................................................................................................................. 7
   Document Outline ................................................................................................................... 7
   Typographical Conventions .................................................................................................. 8
   Contacting Support .............................................................................................................. 8
   Additional Documentation ................................................................................................... 8

1  Prerequisites and Product Overview ............................................................................. 9
   1.1  Prerequisites .................................................................................................................. 9
       1.1.1  System Requirements for DeviceAnywhere Studio .............................................. 9
   1.2  Features ....................................................................................................................... 10
   1.3  Benefits ...................................................................................................................... 10
   1.4  Product Components .................................................................................................. 11
       1.4.1  DeviceAnywhere Studio Modules .................................................................... 11
       1.4.2  DeviceAnywhere Enterprise Portal ................................................................. 14

2  Getting Started .................................................................................................................. 16
   2.1  Log In to the Portal and Launch DeviceAnywhere Studio ........................................... 16
   2.2  Launch and Log In to DeviceAnywhere Studio Locally ............................................. 18
   2.3  Password Management .............................................................................................. 19
   2.4  DeviceAnywhere Studio Interface ............................................................................. 19
       2.4.1  Components ........................................................................................................ 20
       2.4.2  Menu Bar ............................................................................................................. 21

3  Device Interaction ............................................................................................................. 22
   3.1  Device Session .............................................................................................................. 22
       3.1.1  Selecting a Device ............................................................................................... 22
       3.1.2  Device Availability and Status .......................................................................... 26
       3.1.3  Acquiring a Device ............................................................................................. 27
       3.1.4  Latency Indicator ............................................................................................... 30
       3.1.5  Reserving a Device ............................................................................................. 30
       3.1.6  Sharing a Device ................................................................................................. 31
       3.1.7  Releasing a Device ............................................................................................. 31
   3.2  Working with a Device ............................................................................................... 32
       3.2.1  Optimizing Screen Space ................................................................................. 32
       3.2.2  Device Input ....................................................................................................... 34
   3.3  Device Menu ................................................................................................................ 35
   3.4  Device Console ............................................................................................................ 37
       3.4.1  Usage Tips Tab .................................................................................................... 39
       3.4.2  Keyboard Tab ..................................................................................................... 40
       3.4.3  Hardware Tab .................................................................................................... 41
       3.4.4  Audio & Video Tab ............................................................................................ 41
DeviceAnywhere Enterprise Interactive

User Guide

3.4.5 Send SMS Tab.............................................................................................................43
3.4.6 Applications Tab......................................................................................................44
3.4.7 Sharing Tab..................................................................................................................51
3.4.8 Cleanup Tab..................................................................................................................56
3.4.9 Device Log Tab..........................................................................................................57
3.4.10 Network Tab............................................................................................................57
3.4.11 Device FTP Tab.........................................................................................................59
3.4.12 ADB Tunnel Tab ......................................................................................................60
3.4.13 iPhone Tab................................................................................................................62

3.5 View and Export Video for Collaboration.................................................................63
3.5.1 Viewing Video History.............................................................................................64
3.5.2 Exporting Video History..........................................................................................64

3.6 Device Information .....................................................................................................71
3.6.1 Features ...................................................................................................................71
3.6.2 DeviceAnywhere Info .............................................................................................72

3.7 Reporting an Issue ......................................................................................................73

4 Test Case Manager Concepts and Workflow ...............................................................75
4.1 Test Case Manager Overview ....................................................................................75
4.2 Definitions....................................................................................................................75
4.3 Test Workflow ...........................................................................................................76

5 Projects ..........................................................................................................................77
5.1 Creating a Project ........................................................................................................77
5.2 Project Properties ......................................................................................................79
5.2.1 Overview Tab .............................................................................................................79
5.2.2 Devices Tab..............................................................................................................79
5.2.3 Dependencies Tab ...................................................................................................80
5.2.4 Permissions Tab .......................................................................................................81
5.3 Opening a Project.......................................................................................................82
5.3.1 Opening Test Assets .................................................................................................82
5.4 Managing Projects ....................................................................................................83
5.4.1 Project-Level Search .................................................................................................83
5.4.2 Other Functions .......................................................................................................84

6 Creating and Managing Test Cases ..............................................................................87
6.1 Creating a Manual Test Case .....................................................................................87
6.1.1 Test Steps ................................................................................................................89
6.1.2 Step Groups ..............................................................................................................91
6.2 Managing Test Assets ...............................................................................................94
6.2.1 Properties Dialog Box ..............................................................................................94
6.2.2 Opening a Script for Editing .....................................................................................95
6.2.3 Checking In and Closing Scripts ...............................................................................95
6.2.4 Rolling Back Scripts .................................................................................................96
6.2.5 Removing Scripts .....................................................................................................98
6.2.6 Searching for References ................................................................. 98  
6.2.7 Other Functions ............................................................................. 99

7 Creating and Executing Test Cycles ....................................................... 101
  7.1 Creating a Test Cycle ........................................................................ 101
  7.2 Executing a Test Cycle ................................................................. 104
    7.2.1 Selecting a Device and Test Case .............................................. 104
    7.2.2 Executing Test Case Steps ....................................................... 106
    7.2.3 Advancing through Test Cycle Execution ............................... 110

8 Viewing Results .................................................................................. 113
  8.1 Viewing Results from DeviceAnywhere Studio ............................. 113
  8.2 Viewing Results Directly in the Portal .......................................... 113
    8.2.1 Navigating to Results .............................................................. 114
    8.2.2 Overview of Test Cycle Results .............................................. 115
    8.2.3 Viewing Detailed Results ....................................................... 116
About This Document

This document describes how to use Keynote’s DeviceAnywhere Enterprise Interactive (DAE Interactive) for direct device interaction and the scripting and execution of manual tests on smart devices.

DeviceAnywhere Enterprise Interactive is a component of DeviceAnywhere Enterprise, a cloud-based or standalone enterprise solution for interaction with real, live smart devices and manual or automated test execution on them. With DeviceAnywhere Enterprise (DAE), enterprises can access multiple copies of the latest recommended smart devices for manual, and optionally, automated testing of internal or client-facing applications or content. You use our client software, DeviceAnywhere Studio, to control devices remotely over the Internet/network either ad hoc or in a test execution environment. With optional licensing, you can also use DeviceAnywhere Enterprise Automation (DAE Automation) to write and execute automated tests on private (either connected to your local machine or hosted by Keynote) or public (shared) devices. Automated tests can be executed ad hoc or scheduled to run unattended. Finally, DeviceAnywhere Enterprise includes DeviceAnywhere Enterprise Portal for account management, storing and sharing results, and planning your test strategy and target devices.

This document describes how to use DAE Interactive’s powerful features to interact with devices, manage manual test cases, and view and manage manual test results. Functionality provided by DeviceAnywhere Enterprise Automation is covered in the DAE Automation User Guide.

Document Outline

In this document:

**Prerequisites and Product Overview** describes DeviceAnywhere Enterprise prerequisites and features. It also introduces the DeviceAnywhere Enterprise Portal and the DeviceAnywhere Studio client software modules that comprise DeviceAnywhere Enterprise.

**Getting Started** describes how to launch and log in to DeviceAnywhere Studio from the DeviceAnywhere Enterprise Portal.

**Device Interaction** explains in detail the controls and procedures for device interaction in DAE Interactive. This chapter includes information on starting and stopping a device session, working with a device, device input, using various utilities (e.g., to view log files), and accessing commands and device information.

**Test Case Manager Concepts and Workflow** introduces manual testing concepts, the hierarchy of test assets in DeviceAnywhere Studio, and how they fit into the best practice testing workflow.

**Projects** describes how to create and manage projects to contain and organize test assets.

**Creating and Managing Test Cases** describes how to create test cases that describe the end-to-end manual test to be executed by testers.

**Creating and Executing Test Cycles** describes how to create manual test cycles consisting of test cases and how to execute them on the selected set of test cycle devices.

**Viewing Results** describes how to view results from DeviceAnywhere Studio as well as by logging in directly to the DeviceAnywhere Enterprise Portal.
Typographical Conventions

The table below describes the typographical conventions used in Keynote DeviceAnywhere documentation.

<table>
<thead>
<tr>
<th>Style</th>
<th>Element</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blue</strong></td>
<td>Links and email addresses</td>
<td><a href="http://www.keynotedeviceanywhere.com">http://www.keynotedeviceanywhere.com</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Document Outline section describes the structure of this manual.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>User interface elements such as menu items</td>
<td>Click My Devices in DeviceAnywhere Studio.</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Commands, code output, filenames, directories</td>
<td>Right-click the project’s test cases directory.</td>
</tr>
<tr>
<td><strong>Monospace bold</strong></td>
<td>User input</td>
<td>In a command window, type adb devices.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Document titles and emphasis</td>
<td>Refer to the DeviceAnywhere Enterprise Automation User Guide to learn how to script.</td>
</tr>
</tbody>
</table>

Contacting Support

If you have any comments or suggestions regarding this document, contact Keynote Support. For inquiries about DeviceAnywhere product demonstrations and consulting services, contact your Keynote Solutions Consultant.

Customers can find additional support information at http://support.keynote.com or 1-888-KEY-SYST (539-7978).

Additional Documentation

You can find information at http://www.keynotedeviceanywhere.com/dae-documentation.html. This includes the following documents:

- DeviceAnywhere Enterprise Release Notes
- Tips for Interacting with Devices
- DAE Automation User Guide

Users with licenses to attach and test on local devices can find these additional documents at http://www.keynotedeviceanywhere.com/dae-pvt-devices-documentation.html:

- Local Device Server Installation Guide
- Onboarding Guides for Android, iOS, and BlackBerry devices

You can also access documentation from the Help menu in DeviceAnywhere Studio.
1 Prerequisites and Product Overview

Keynote’s DeviceAnywhere Enterprise enables you to test mobile applications and device features manually on real, live, smart devices (smartphones, tablets). Optionally, you can add licensing to use DeviceAnywhere Enterprise Automation to write, manage, and execute automated tests on dedicated, local, or shared devices. Keynote DeviceAnywhere’s patented device interaction technology enables you to test any application and perform the same operations on a device that a real user would—you can send input to the device (e.g., key presses or touch screen events), receive device output, perform hardware operations (e.g., flip device open), and upload test results to a web portal.

DeviceAnywhere Enterprise is accessed as a set of modules in the DeviceAnywhere Studio client software.

This chapter describes prerequisites for using DeviceAnywhere Enterprise, product features, benefits, and product components.

1.1 Prerequisites

To use DeviceAnywhere Enterprise, you require the following:

- A license for either DeviceAnywhere Enterprise Interactive (DAE Interactive), DAE Automation, or both
- A user account enabling you to log in to the DeviceAnywhere Enterprise Portal from www.keynotedeviceanywhere.com and download and log in to DeviceAnywhere Studio—if you require an account, contact your system administrator.
- DeviceAnywhere Studio client software, auto-launched from the DeviceAnywhere Enterprise Portal or manually launched from your desktop shortcut—see System Requirements for DeviceAnywhere Studio below.
- A high-speed Internet/network connection

1.1.1 System Requirements for DeviceAnywhere Studio

Minimum system requirements are as follows:

- 2 GHz dual-core processor (Pentium 4 or higher)
- 2 GB RAM
- At least 10 GB available hard disk space
- Monitor with at least 1600x900 screen resolution
- Optional: Audio card for sound input/output

**NOTE** Both 32- and 64-bit processing is supported on Windows.

JDK v1.5+ must be installed for Mac OS/Linux
1.2 Features

With DeviceAnywhere Enterprise for smart mobile devices, you can:

- Interact with and control real, live, in-network smart devices over the Internet/network using DeviceAnywhere Studio.
- In addition to shared devices for the cloud-based DAE service, request hosted devices for private access or even install and manage devices locally.
- Test any functionality or application across all platforms and smart device models—you can execute test cases that perform the same operations that a real user would. Unlike emulators that control only a subset of device functionality, DAE provides comprehensive support for device features.
- View real-time interaction and test execution on mobile devices in DeviceAnywhere Studio.
- Use powerful and convenient product features to send an SMS message to the device, copy and paste text onto the device and, upload/remove applications, and share the device screen with other users.
- Avail of features to aid in debugging for Android, BlackBerry, and iOS devices
- Define manual test cases with instructions, proofs required, expected results, and constraints for manual testers.
- Manage and track completion rates of manual test plans.
- Execute tests and generate customized test results, complete with screenshots or device video.
- Store and view test results.
- Optionally, define and run automated tests on smart devices (with a license for DAE Automation).
- Schedule automated tests to run unattended in the DeviceAnywhere Studio UI or using a command-line scheduling tool; view scheduled script execution in a web dashboard.
- Define and run mixed manual and automated test cases
- Collaborate with other users in your account by sharing the device screen, screenshots, video capture, and uploaded test results.
- Use our web-based Device Planner wizard to plan test devices and ensure test coverage of your application/content across key factors that can impact its behavior and performance.
- Use the Test Planner module in the DeviceAnywhere Enterprise Portal to create execution plans, which can then be imported to DeviceAnywhere Studio and built out with specific commands and instructions for testers. As the test plan is carried out in DeviceAnywhere Studio, updates are shown in the Test Planner.

1.3 Benefits

DeviceAnywhere Enterprise combines the convenience of manual (and automatic) tests with the accuracy of real, live devices (as opposed to emulators and simulators) and enables you to:

- Flexibly access multiple copies of supported devices from a shared device bank or deploy dedicated devices for automated testing.
- Make the same set of devices available to distributed test teams.
If using shared devices, avoid investment in devices and airtime plans to account for differences in make, model, platform, OS version, carrier, location, etc.

Define unambiguous and uniform tests for distributed teams.

Define tests (manual or automated) that apply across all test devices and mobile platforms.

Manage and view progress of test plans in a central location.

View and manage your test results for multiple environments from a central location, accessible over a network connection.

Avail of simple, concurrent user-based licensing and enhanced support.

1.4 Product Components

This section describes the components of DeviceAnywhere Enterprise.

The DeviceAnywhere Studio client application enables you to interact in real-time with smart devices over the Internet/network and to define and run tests.

The DeviceAnywhere Enterprise web portal provides access to account management features, results, and test and device planning tools.

1.4.1 DeviceAnywhere Studio Modules

The DeviceAnywhere Studio client application is the primary interface for interacting with devices and defining, managing, and running test cases. DAE Interactive includes the Test Center and Test Case Manager modules, or views, which you can access from the application sidebar. With an optional license, you can also access automated scripting in the Test Automation view.

Figure 1-1 DeviceAnywhere Studio Sidebar—Module List and Icons
1.4.1.1 Test Center

This view allows you to view all devices and interact with them. You can acquire devices, press keys/touchscreens, upload applications, and otherwise interact with devices in this view.

Figure 1-2 Test Center View

1.4.1.2 Test Case Manager

You can define and run manual test cases/cycles in this view. The Test Case Manager consists of Test Case Editor and Test Case Runtime. Test Case Manager is also used in association with the Test Automation view to run mixed manual and automated test cases.
**Test Case Editor**

The Test Case Editor is the interface for creating manual test cases. You can also link manual test case steps to automated scripts from here.

*Figure 1-3 Test Case Editor*

**Test Case Runtime**

You can create and run manual and partially automated test cycles from Test Case Runtime. You can also track the progress of test cycles and view uploaded results from here.

*Figure 1-4 Test Case Runtime*
1.4.1.3 Test Automation

You can define automated test assets (actions, states, test cases, test cycles) in this view. You can run and debug scripts, and view and upload results to the DeviceAnywhere Enterprise Portal from here.

The Test Automation view shares the same library of projects as Test Case Manager but only lists automated test assets.

Figure 1-5 below shows a script in the visual scripting environment in the Test Automation view.

**Figure 1-5 Test Automation Visual Scripting Environment**

1.4.2 DeviceAnywhere Enterprise Portal

The DeviceAnywhere Enterprise Portal is a web-based tool for planning and tracking testing on mobile applications, devices, or content. It is a one-stop shop that enables you to:

- Quickly create lists of target test devices based on Keynote’s analysis of your test needs and criteria.
- Create and supervise high-level test plans that are automatically ported to DeviceAnywhere Studio for detailed implementation and execution.
- View, store, and share test results for all DeviceAnywhere test environments that you have access to (e.g., DeviceAnywhere Enterprise, DeviceAnywhere Test Center Developer, and any dedicated environments).
- Manage your account.
You can access DeviceAnywhere Enterprise Portal by logging in to www.keynotedeviceanywhere.com.

Figure 1-6 DeviceAnywhere Enterprise Portal Home Page

Select your DeviceAnywhere environment under **My Environments** (in the left panel) to launch DeviceAnywhere Studio, view test results, administer your account, and more.
2 Getting Started

To begin using DeviceAnywhere Enterprise, you must log in to www.keynotedeviceanywhere.com, and then download and launch DeviceAnywhere Studio, found in the lower left corner of your screen.

Returning users can launch DeviceAnywhere Studio by logging in to www.keynotedeviceanywhere.com or by clicking the DeviceAnywhere Studio shortcut on their desktop.

NOTE Ensure that your system meets the minimum requirements for DeviceAnywhere Studio.

2.1 Log In to the Portal and Launch DeviceAnywhere Studio

The DeviceAnywhere Enterprise Portal provides links to account management features, results, and training and support resources. The portal also provides a link for first-time users to install DeviceAnywhere Studio.


2. Click Login at the top right corner to log in (you should already have signed up for an account or been given one by your system administrator).

3. Enter your credentials and click Log In.

You are directed to the landing page of the DeviceAnywhere Enterprise Portal, where the environments you have access to are listed.
4 Select the correct environment under **My Environments**.

5 If launching DeviceAnywhere Studio for the first time, select **Download DeviceAnywhere Studio** (be sure to select the appropriate client platform).

If you are a returning user, select your test environment under **My Environments** in the left pane and then **Access devices**.
This automatically launches DeviceAnywhere Studio from your client machine and you are logged in.

### 2.2 Launch and Log In to DeviceAnywhere Studio Locally

Returning users can launch DeviceAnywhere Studio from their local machines.

Enter/confirm your credentials and click **Login**.

*Figure 2-1 Logging in to DeviceAnywhere Studio*

The figure below shows the application home screen.
2.3 Password Management

If you have accounts on multiple environments, e.g., DeviceAnywhere Enterprise as well as DeviceAnywhere Test Center Developer, which are accessible from the DAE Portal (http://portal.keynotedeviceanywhere.com), a password change in any environment is valid for all other environments.

**NOTE** The password must be the same across different environments for a global password reset to work.

For example, if your newly created DAE account requires a password change upon next login, the changed password in DeviceAnywhere Studio is also valid for logging in to the DAE Portal from www.keynotedeviceanywhere.com and launching DeviceAnywhere Studio from there for another environment, e.g., TCD. If you access your Test Center Developer account from the DAE Portal, a password change in the DAE Portal applies when you next launch DeviceAnywhere Studio pointing to Test Center Developer or directly access the Test Center Developer Portal (https://myda.deviceanywhere.com).

2.4 DeviceAnywhere Studio Interface

Once DeviceAnywhere Studio is launched, the Test Center view is displayed by default. Other product modules and views are accessible through the sidebar on the left of the screen.
2.4.1 Components

The figure below illustrates the components of the DeviceAnywhere Studio interface when pointing to a DeviceAnywhere Enterprise environment.

Figure 2-3 DeviceAnywhere Studio Interface Components

- **Title Bar**—The title bar shows the product name and version. The name of the user logged in is shown in parentheses.

- **Menu Bar**—The menu bar provides a set of drop-down menus for certain functions based on the view/module selected DeviceAnywhere Studio. You can find the following menus in the Test Center view: **File, Device, View, Go, Tools, and Help**.

- **Sidebar**—The sidebar at the left of the application window allows you to switch between modules licensed to your account. It provides access to views such as Test Case Manager and Test Automation. You can display module names or icons in the sidebar by clicking **View > Minimize/Show Sidebar**.

- **Selected View**—The name of the currently selected view is displayed.

- **Sort/Filter Controls**—The device list can be sorted with a drop-down list for **Carrier, Operating system**, or **Screen size**. You can also **Filter** the device list by any string or search by multiple criteria and operators (see **Sorting Devices** and **Filtering Devices** for details). You can also opt to view devices associated with **Projects** created in the Test Case Manager view.

- **Device List**—The device list shows devices based on sort or filter criteria applied. Icons indicate device availability.
Workspace—The large pane on the right of the screen is the primary workspace for all views. In this pane, you can view product information, acquired devices, and test scripts being developed or executed.

Device—Each acquired device is opened in a separate tab in the workspace. You can interact with the device by pressing keys and/or the touchscreen, using your computer keyboard, or the device console.

Device menu—Right-click an acquired device in the device list or the workspace to access the device menu. This menu contains commands to change device display size and orientation, view and export video history, view device information, report an issue, and release the device. An abridged version of this menu is available when you right-click a device that is not acquired by you in the device list.

Device console—The device console is the control panel for several device functions, including data entry, hardware controls, audio and video settings, sending an SMS message, uploading/removing applications, sharing the device, and accessing debug tools.

Latency indicator—These icons visually indicate any delay in displaying screen updates. Green or yellow dots indicate acceptable levels of latency. If you consistently see a red dot, check the quality and speed of your Internet connection to ensure the best device interaction experience.

Status Bar—The status bar at the bottom of the screen displays some DeviceAnywhere Studio log messages and provides error information.

2.4.2 Menu Bar

The DeviceAnywhere Enterprise menu bar contains the following menus:

Table 2-1 Test Center Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>This menu allows you to restart or exit DeviceAnywhere Studio. You can also switch profiles, i.e., log in to different DeviceAnywhere test environments that you have licensed access to.</td>
</tr>
<tr>
<td>Device</td>
<td>This menu offers options for acquiring devices, and provides access to device information and reporting device issues. This is the same menu you would see by right-clicking a device in the active workspace tab.</td>
</tr>
<tr>
<td>View</td>
<td>This menu allows you to show or hide the sidebar and the status bar.</td>
</tr>
<tr>
<td>Go</td>
<td>This menu allows you to switch views in DeviceAnywhere Studio. It has the same function as the sidebar.</td>
</tr>
<tr>
<td>Tools</td>
<td>You can view your shared devices using this menu.</td>
</tr>
<tr>
<td>Help</td>
<td>This menu provides access to the latest DeviceAnywhere documentation. You can also report issues to Keynote Support and view the copyright notice, version number, and other information about DeviceAnywhere Studio.</td>
</tr>
</tbody>
</table>
3  Device Interaction

DeviceAnywhere Enterprise, based on Keynote’s core Direct-to-Device technology, enables remote (network) access to real, smart devices on live carrier networks.

Keynote enables testers to test mobile/smart devices and applications from the convenience of their desktops. They have remote access to all device features, including the keyboard, touchscreen, ringer, speaker, battery, power, data cable, and of course, applications.

Additional features in DeviceAnywhere Studio enable you to send SMS interrupts to the device, upload applications, access debugging tools and log files, and collaborate with team members by sharing the device screen or device interaction snapshots and video.

This chapter covers the following aspects of interacting with devices in DeviceAnywhere Enterprise:

- Conducting a device session
- Working with a device to optimize screen space and enter data/touchscreen events/key presses
- Device control commands available in the device menu
- Functionality available in the device console
- Viewing and exporting device video and other collaboration features
- Viewing device information
- Reporting an issue

NOTE While this chapter covers device interaction in the Test Center view, most information here also applies to device interaction in the Test Case Manager and Test Automation views.

3.1  Device Session

The Test Center view enables you to interact with devices in real-time. This section describes the commands and procedures involved in conducting a device session.

3.1.1  Selecting a Device

You can search for a device by using sort and filter controls.

3.1.1.1  Sorting Devices

Devices in DeviceAnywhere Enterprise are displayed unsorted by default. You can, however, use the Group by drop-down list to sort by (see Figure 3-2 below):

- Operating system—Devices are grouped by platform (Android, BlackBerry, iOS).
- Carrier—Devices are grouped by service provider, e.g., AT&T, Sprint.
- Screen size—Devices are grouped by screen resolution, e.g., 768 x 1024, 720 x 1280.

3.1.1.2  Filtering Devices

You can further pare down the displayed devices by using the free-form text Filter (see Figure 3-2 below). With every keystroke entered into the text filter, the device list is dynamically adjusted. The filter finds
matching text in the make, model, or MCD number of devices. Filtering by the word “online” displays all online devices.

**NOTE** The MCD is a unique identifier for each device assigned by Keynote (see [Device Information](#)).

Clicking the filter icon enables you to search by multiple, more granular search criteria.

1. Select a device feature by which you want to search for devices, e.g., the ability to send **SMS** interrupts to the device (shown in the image below).

![Advanced Device Filter](image)

2. Select an **Operator** and a delimiting **Value**. For several features, you can simply opt to search for devices that offer them (e.g., searching for SMS capability, shown below).

![Advanced Device Filter](image)

When searching by **Operating System**, you can search for devices with OS versions equal to, greater than or equal to, or less than or equal to the selected **Value**, e.g., “Android 2.3.x” below.

**NOTE** Searching by minor OS version has always been supported by typing into the free-form text **Filter** field.
Add or remove search criteria (Add Row, Remove Last Row) as desired. Devices matching all the search criteria will be listed in results.

Click Apply Filter. To clear filter results, delete all search criteria and click Apply Filter in the Advanced Device Filter dialog box.

3.1.1.3 Device Groupings in the Device List

The device list displays a single icon for multiple copies of like devices, i.e., devices of the same make and model. For example, if there are five copies of the iPhone 4, one iPhone 4 appears in the device list. For each device group, the number of copies available is displayed. Devices are grouped in this manner regardless of the sort and filter criteria.

You can view the individual copies in a device group by right-clicking the icon and selecting Expand Group (select Collapse Group to collapse the list).
The figure below shows an unsorted device list that has been filtered by the term “Apple.” Some device groups are collapsed while one device group is expanded to show all available copies of the same device make/model.

**Figure 3-2 Device List**

### 3.1.1.4 Viewing Project Devices

You can also view devices associated with projects created in the Test Case Manager view. These projects are created to contain manual test assets.

1. Select the **Project** radio button.
2. Select a project from the drop-down list. If the project is not already open, you will see the following message.
You can use projects to create custom device groupings for display in the Test Center view.

### 3.1.2 Device Availability and Status

Device availability is indicated by status icons that appear next to each device in the device list. The table below lists and describes each status icon.

#### Table 3-1 Device Status Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Samsung Nexus S" /></td>
<td>Device is online and available to be acquired.</td>
</tr>
<tr>
<td><img src="image" alt="Motorola DROID Pro" /></td>
<td>Device is offline and cannot be acquired.</td>
</tr>
<tr>
<td><img src="image" alt="Apple iPad 2" /></td>
<td>Device is locked by another user and cannot be acquired.</td>
</tr>
<tr>
<td><img src="image" alt="Apple iPad" /></td>
<td>Device is acquired by you and is inaccessible to other users until you release it.</td>
</tr>
<tr>
<td><img src="image" alt="BlackBerry 9300 (Curve 3G)" /></td>
<td>Device session has just ended, and device is temporarily unavailable as it is being “cleaned up” before being made available. This icon appears after you release the device.</td>
</tr>
</tbody>
</table>
### 3.1.3 Acquiring a Device

Only one user can use a device at a time in DeviceAnywhere Studio. In order to interact with a device in DeviceAnywhere Studio, you must acquire (lock) it so that you have exclusive use of it for the duration of your session. When you have located the device you want in the device list:

1. Ensure that the device is available to be acquired (green power icon).
2. Right-click the device and select **Acquire Device**.

   To select another copy, click the make/model icon and select **Acquire Another Device**. You can also expand the device group and acquire the specific device you want.

As soon as you acquire a device, it appears in a tab in the workspace along with its device console. Now the device is ready to register key presses, touchscreen taps, or other activity.

You can work with any number of devices in the Test Center view. Each device you acquire appears in a separate tab in the workspace.

Click the tab of the desired device to view the device and access its controls in the workspace. You can also toggle between docked tabs by using the drop-down menu located at the top right of the workspace (see image below).
Figure 3-4 Multiple Acquired Devices

3.1.3.1 Waking a Device Up

The device screen is grayed out after short periods of inactivity to save power. Click on the link that appears to wake the device up. You can also right-click the device and select **Wake Device Up**.

Figure 3-5 Wake Device Up
3.1.3.2 Restarting a Device

You can restart an acquired device that has been powered off by:

- Right-clicking the device and selecting **Restart Device**
- Clicking on the link that appears in the onscreen notification:

  ![Device is powered off](image1)

  The device displays the following notification as it is being powered on.

  ![Device is being powered on...](image2)

3.1.3.3 Waiting for a Device

If a device is acquired by another user, you can choose to wait for the device. Once the other user releases the device, it is made available to the first person in the queue.

To wait for the device:

1. Right-click the device and select **Wait for Device** (clock icon).

2. In the dialog box that appears, the option to automatically acquire the device as soon as it is available is selected by default. If you uncheck the option, you will have three minutes within which to acquire it yourself before it is made available to other users. You can also opt to receive email notification when the device is available.

![Wait for Device](image3)
The device is listed in the device list with a clock icon to indicate that you are waiting for it. The device is also displayed in a workspace tab with a notification that you are waiting for it.

3.1.4 Latency Indicator

When you acquire a device, latency indicator icons to the right visually indicate any delay in displaying screen updates.

Figure 3-6 Latency Indicator Icons

Green dots (5, 4, or 3) indicate acceptable levels of latency. As latency increases, you might see 2 yellow or a single red dot. If you consistently see a red dot, check the quality and speed of your Internet connection to ensure the best device interaction experience.

3.1.5 Reserving a Device

You can reserve any device up to 2 days in advance. When you right-click a device in DeviceAnywhere Studio and select Reserve Device, you are directed to the Reservations tab in the DAE Portal. Reservations start times begin every 15 minutes on the quarter of the hour. The maximum reservation time is 4 hours.
3.1.6 Sharing a Device

You can invite other users in your account to view a device that you currently have acquired. While you retain control of the device, sharing enables another user you invite to view your interaction with the device. The other user must be logged in to DeviceAnywhere Studio in order to view the shared device. Sharing is enabled in the device console and is discussed in detail below.

3.1.7 Releasing a Device

After a device has been released, it becomes available to other users. There are several ways to release an acquired device:

- Right-click the device in the workspace > Release Device
- Right-click on the device in the device list > Release Device
- Close the device tab in the workspace—the device is automatically released.

As the device is being released, the screen displays the following message.

Figure 3-7 Device Release

![Device is being released...]

When a device is released, cleanup scripts delete session-specific information before it is made available to other users.

3.1.7.1 Inactivity Timeout

Devices are automatically released after 30 minutes of inactivity. If an acquired device is inactive for 28 minutes, a pop-up alert warns that it will automatically be released. Click Keep Using to continue using the device and reset the timer or click Release to release the device immediately.

Figure 3-8 Inactivity Alert

![Release Device Alert]

If you close the window, the timer is not reset. With continued inactivity, the window reappears at 1-minute intervals. If no option is selected, the device is automatically released after 30 minutes of inactivity.

3.1.7.2 Release Devices Alert

If you exit DeviceAnywhere Studio with a device still acquired, you are alerted before the program shuts down completely. You can choose to release or retain the device if you plan to log back in shortly.
Figure 3-9 Release Devices Alert

If you retain the device, it remains acquired for 5 minutes, after which it is automatically released.

3.2 Working with a Device

In DeviceAnywhere Studio, you can control a device remotely by using your mouse and keyboard to click the device screen and enter data to perform all the functions you could if it were in your hand. Each key and button of an acquired device that you see in DeviceAnywhere Studio is fully functional, as are touchscreens. With each interaction, the device screen is updated to reflect any changes.

This section discusses how to:

- Optimize screen space in your application window for device interaction.
- Use your mouse and keyboard to navigate a device and enter data. (You can also use the text entry utility for data entry—see Device Console below.)

Later sections also discuss performing hardware operations such as flipping a device open/close (see Device Console below).

3.2.1 Optimizing Screen Space

You can do the following things to adjust the screen space available for working with your device:

- Maximize/minimize the DeviceAnywhere Studio window.
- Minimize the sidebar to display icons only (View > Minimize Sidebar).
- Adjust panes by dragging the sizing handle that appears when you hover over the edge of a pane or use the sizing arrows between panes.
- Adjust device zoom settings—as devices are rendered pixel for pixel, some tablet devices can appear larger than life if their screen resolution exceeds that of your monitor. Right-click the device and select Zoom to adjust device size. Choose a zoom percentage (see Figure 3-10 below).
iPhone devices have zoom buttons to the side which allow you to zoom in and out to view content in browser windows.

- Change device orientation (if supported by the device) or flip state (if supported by the device)—right-click the device and select **Orientation** or **Flip State** (see Figure 3-11 below):
  - **Vertical**
  - **Left** (turn left to display horizontally)
  - **Right** (turn right to display horizontally)
  - **Flip Open** (only on devices with a pull-out keyboard; orientation is automatically changed to match the flip state)
  - **Flip Closed** (only available when flipped open)

- View the device and console in a separate window by clicking **Pop Out** at the top-right corner of the workspace; click **Pop In** to anchor the device tab to the workspace again (see Figure 3-12 below).
3.2.2 Device Input

Device input consists of operating a device’s touchscreen and/or keyboard for navigation as well as data entry. Several methods of device input are supported in DeviceAnywhere Studio:

- Clicking device keys/touchscreen with a mouse
- Using a computer keyboard to enter data
Typing/pasting text into Text entry field in device console (covered below)

### 3.2.2.1 Touchscreen Swipes and Free-Hand Gestures

You can swipe or perform a free-hand gesture on a touchscreen using your mouse. Use one of these two methods:

- Hold down the Shift key and drag your mouse in a free-hand motion across the device screen. This performs the gesture in real time.
- Hold down the Ctrl key and drag your mouse across the device screen in a straight line to swipe. As you drag the mouse, a green arrow highlights the length and direction of your swipe. The swipe is performed after the mouse button is released.

**NOTE** The device screen displays the message below if you attempt to perform a touchscreen gesture on a non-touchscreen device.

```
Touchscreen not supported.
```

### 3.2.2.2 Long Key Presses

Certain device interactions such as powering off a device require a key to be pressed for a few seconds. This is accomplished by holding down your keyboard Shift key and then pressing the device key.

### 3.3 Device Menu

The device menu in the Test Center view offers several commands for initiating/terminating a device session, hardware functions, viewing video history for team collaboration, viewing device information, and reporting an issue to Keynote Support. Most of these options are discussed in detail in the sections of
this chapter. They are also listed and briefly described in Table 3-2 below. (Also see the powerful device control and interaction options available in the Device Console.)

To access the menu of an acquired device, right-click the device in the device list or the workspace. You can also click Device in the menu bar of DeviceAnywhere Studio—this displays the device menu for the active device.

The figure below shows the options in the device menu of an acquired device.

Figure 3-13 Device Menu of Acquired Device

The full device menu only appears for an acquired device; an abridged menu appears when you right-click a device that you do not have acquired.

The figure below shows the device menu for a device that is not currently acquired by you.

Figure 3-14 Device Menu of a Device Not Acquired by You

<table>
<thead>
<tr>
<th>Device Acquired by Another User</th>
<th>Available Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for Device</td>
<td></td>
</tr>
<tr>
<td>Reserve Device...</td>
<td></td>
</tr>
<tr>
<td>Report an Issue...</td>
<td></td>
</tr>
<tr>
<td>Device Info...</td>
<td></td>
</tr>
</tbody>
</table>

The table below describes device menu options.

Table 3-2 Device Menu Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Sub-Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquire Device</td>
<td></td>
<td>Acquires device. See Device Session for more information.</td>
</tr>
<tr>
<td>Release Device</td>
<td></td>
<td>Releases device back to device pool. See Device Session for more information.</td>
</tr>
</tbody>
</table>
### Menu Options and Sub-Options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Sub-Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for Device</td>
<td></td>
<td>Waits to acquire a device after it is released by another user. Instead of automatically acquiring the device, you can also opt to receive an email notification of its availability. See Device Session for more information.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Choose a zoom percentage.</td>
<td>Changes size of device in workspace. See Optimizing Screen Space for more information.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Flip Open, Vertical, Left, Right</td>
<td>Turns device to change orientation or flips it open.</td>
</tr>
<tr>
<td>Flip State</td>
<td>Flip Open, Flip Closed</td>
<td>Flips device open/closed. See Optimizing Screen Space for more information.</td>
</tr>
<tr>
<td>Export Frames</td>
<td>Current frame, Frames from history, Video from history, Upload frames</td>
<td>Exports screenshots or video of device interaction, which can be saved to the file system or the web portal. See Exporting Video History for more information.</td>
</tr>
<tr>
<td>Show Video History</td>
<td></td>
<td>Displays a slider below the device enabling you to view frames from the history of the device session. See Viewing Video History for more information.</td>
</tr>
<tr>
<td>Enter Text from Clipboard</td>
<td></td>
<td>Allows you to paste data (alpha, numeric, or URL) from the clipboard into a selected field on the device. The device log in the device console is updated after you paste data. See Device Console for more information.</td>
</tr>
<tr>
<td>Wake Device Up</td>
<td></td>
<td>Wakes device up when screen goes dark after short periods of inactivity. See Device Session for more information.</td>
</tr>
<tr>
<td>Restart Device</td>
<td></td>
<td>Restarts a device. See Device Session for more information.</td>
</tr>
<tr>
<td>Stop Monitoring</td>
<td></td>
<td>Closes the tab of a shared device that you have been viewing. See Sharing Tab for more information.</td>
</tr>
<tr>
<td>Reserve Device</td>
<td></td>
<td>Enables you to reserve a device for up to four hours at a time and two days in advance. See Device Session for more information.</td>
</tr>
<tr>
<td>Report an Issue</td>
<td></td>
<td>Submits a ticket to the Keynote Support portal. See Reporting an Issue for details.</td>
</tr>
<tr>
<td>Device Info</td>
<td></td>
<td>Opens the Device Information window.</td>
</tr>
</tbody>
</table>

### 3.4 Device Console

A console is automatically displayed in the workspace of the Test Center view when you acquire a device.

**NOTE** The console also accompanies a device that you acquire and work with in the Test Case Manager and Test Automation views.

The console enables you to interact with the device, adjust settings, and check its status. The console consists of a display area with control icons on the left and tabs at the top. Click a control icon to access the tabs associated with it.
Table 3-3 Device Console Icons and Tabs

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Click to view usage tips.</td>
<td>Usage Tips</td>
<td>Displays tips and tricks for working with the device.</td>
</tr>
<tr>
<td>🔄</td>
<td>Click to interact with device and adjust settings</td>
<td>Keyboard</td>
<td>Send key presses and data to device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hardware</td>
<td>Perform hardware operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Audio &amp; Video</td>
<td>Adjust audio and video settings.</td>
</tr>
<tr>
<td>🔧</td>
<td>Click to access additional device tools.</td>
<td>Send SMS</td>
<td>Send SMS interrupts to device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Applications</td>
<td>Upload applications to DeviceAnywhere repository and device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sharing</td>
<td>Share device screen with another user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clean up</td>
<td>Run cleanup scripts on the device.</td>
</tr>
<tr>
<td>📱</td>
<td>Communicate with device.</td>
<td>Device Log</td>
<td>View device log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Network</td>
<td>Check Wi-Fi connectivity on the device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Device FTP</td>
<td>Open an FTP tunnel to the device file system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ADB Tunnel</td>
<td>Open an ADB tunnel to the device (Android only).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>iPhone</td>
<td>Remove all applications (iPhone only).</td>
</tr>
</tbody>
</table>

Hover over console icons to see tooltips.

Figure 3-15 Console Icon Tooltips

By default, the console opens on the **Keyboard** tab. If you re-acquire a device during the same session, the console opens on the tab last used.
Console tabs are discussed in the sections below.

### 3.4.1 Usage Tips Tab

Clicking the blue exclamation icon in the device console displays the **Usage Tips** tab. This tab displays device-specific tips and useful information. If you acquire a device for the first time, the console opens on this tab by default.

**Figure 3-17 Usage Tips**
3.4.2 Keyboard Tab

The **Keyboard** tab is accessible by clicking the “control device” icon and enables you to send key presses and data to the device.

3.4.2.1 Text Entry Method

Enter a keyboard or touchscreen sequence in the **Text entry** field and press **Send**. You can type or paste text into this field.

*Figure 3-18 Entering Text Using the Console*

You can also directly paste a string from your clipboard:

1. Copy the required text to the clipboard.
2. Select the device field into which data is to be entered.
3. Select the appropriate **input mode** from the console **Keyboard** tab.
4. Right-click the device and select **Enter Text from Clipboard**.

The **Log** section beneath the **Text entry** field displays all interaction with the device, whether by directly clicking on the device or by using the console. Touch events are displayed with touch coordinates.

3.4.2.2 Input Mode

You must specify an appropriate **Input Mode** for all text entry into a device, depending on the type of field the text is being entered into—select **Alpha** (default) for an alphanumeric field such as the body of a note, **Numeric** for a numeric field such as a phone number, **Web** for the URL field of a browser, or **Messaging** for the address field of a text message.
NOTE Alphanumeric fields support both letters (a, b, c…) and numerals (1, 2, 3…). Even if entering only numeric data into an alphanumeric field (such as a zip code into the body of a text message), you must set the key mode to Alpha.

3.4.3 Hardware Tab

In the Hardware tab (“control device” icon), you can perform hardware operations such as disconnecting/reconnecting the battery, turning the camera light on/off, or changing device orientation and flip state (if supported on the device).

Depending on the device, hardware controls include the following:

- Disconnect/Connect battery
- Turn on/turn off camera light
- Turn Left/Right/Vertical or Flip Open/Closed to change orientation/flip state

The controls available depend on the features supported by a device.

Figure 3-19 Hardware Controls for Device with Pull-Out Keyboard and Accelerometer

3.4.4 Audio & Video Tab

Controls for audio and video quality are located in the Audio & Video tab (“control device” icon). Audio and video settings in the device console allow you to choose between quality and efficiency. Offshore teams accessing devices from remote locations can reduce audio/video quality if faced with network latency while still being able to perform functional tests safely.
3.4.4.1 Video Settings

The following video settings are available (see adjusted video settings in Figure 3-20 below):

- The **Video quality** slider allows you to choose between resolution/clarity and efficiency. The **Best quality** end of the slider engages optimum video on the device. Moving the slider closer to **Best performance** increasingly compresses video data, reducing the amount of data being transferred, thus reducing latency.

- The **Speed Interaction for Fast Motion** check box for some smart devices reduces screen resolution and image quality when the device screen is changing rapidly. This effectively increases frame rate and reduces response time from key press to screen update. The image quality of the device screen is not affected when it is stable for more than one second.

  This feature is enabled by default. However, if you disable it for a device, DeviceAnywhere Studio remembers your setting for subsequent sessions.

- The **Color depth** drop-down list allows you to choose between **High (16 bit)**, **Medium (12 bit)**, or **Low (7 bit)** color depth.

  **NOTE** Color depth is the number of bits used to represent the color of a single pixel in a bitmapped image or frame buffer—higher color depth gives a broader range of distinct colors.

3.4.4.2 Audio Settings

Audio settings consist of quality sliders and mute/unmute options for the **Speaker** and **Microphone**. Both the speaker and microphone are muted by default. Click **Unmute** for either control to adjust its slider. Volume bars indicate the volume level of the speaker and microphone.

See **View and Export Video for Collaboration** for more on video functions in DeviceAnywhere Studio.
3.4.5 Send SMS Tab

The **Send SMS** tab of the device console is accessible by clicking the “tools” icon and allows you to send SMS messages to the acquired device for interrupt testing. This feature can also be used to send a URL to the device. This is an optional feature and requires an SMS modem in standalone systems (contact your Keynote Solutions Consultant for assistance).

To send an SMS to the device:

1. Select the tools icon and then the **Send SMS** tab.
2. Type or copy and paste the desired message into the **Send SMS** field.
3. Click **Send**.

A log of each SMS sent to the device is kept under **SMS History**.
3.4.6 Applications Tab

The **Applications** tab is accessible by clicking the tools icon of the device console. This section covers:

- **Supported mobile platforms and requirements**
- **Uploading applications** from a web location or your file system to the DeviceAnywhere application repository, including advanced upload options to enable object-level scripting on Android and iOS devices—Applications uploaded can each be up to 100 MB in size.

The DeviceAnywhere repository is a web-based location for application storage that all users from your organization can access from DeviceAnywhere Studio.

- **Delivering an application** to the device using data cable or by sending a link to it via SMS message
- **Deleting applications** from the repository

### 3.4.6.1 Supported Mobile Platforms and Requirements

- **Android**
- **BlackBerry**—Application delivery by data cable requires JavaLoader on device server; application upload not supported on BlackBerry OS 10+ devices
- **Brew**
Brew MP—You can install Brew MP applications onto the latest Brew MP devices (version 1.0.2 or higher). In standalone environments or for customers with access to local devices, this feature requires that the Brew MP SDK (version 7.11.6 or higher) be installed on the Ensemble Server hosting the Brew MP device. The SDK is available at https://developer.brewmp.com/tools/brew-mp-sdk. Several other configuration steps must be performed in standalone systems to enable this feature—contact your Keynote Solutions Consultant for details.

When uploading your application, you need to provide the Class ID assigned to it by the Brew MP ClassID Generator (available at http://developer.brewmp.com/tools/class-id-generator; requires an account). See https://developer.brewmp.com/resources/primers/brew-mp-application-development-primer/classids-and-commercialization for information on CIDs.

iOS—Application upload of .ipa files on jailbroken or non-jailbroken iOS 5+ devices; see Advanced Upload Options for iOS and Android. If you have on-premise iOS 7 devices, they must have the latest version of iTunes to upload applications.

Windows Phone 7—Device must be registered to a Windows Phone 7 developer account; requires Visual Studio for Windows Phone 7, Windows Phone 7 SDK, and Zune on device server.

Windows Phone 8—Applications must be in XAP file format.

3.4.6.2 Storing Applications in the DeviceAnywhere Repository

To upload an application to the repository:

1. Navigate to the Applications tab in the device console of an acquired device.

2. Add an application to the repository:
   - Application from the file system
     a. Click Add Application.
     b. In the dialog box that appears, enter a Name for the application to be uploaded. This name will be displayed in DeviceAnywhere Studio. Be sure to name applications descriptively so they can easily be differentiated. This is especially helpful when you upload multiple versions of the same application to the repository.
c Select an application **Type** from the drop-down list—only applications of this type will be listed for selection.

d Enter the application **Version**.

e For Brew MP applications, enter the **Class ID** assigned to the application by the Brew MP ClassID Generator.

f Click **Add file** and select the application file from your file system. If the application consists of multiple files, repeat this step as required. The selected files are displayed in the **Application files** pane. (To remove a file, select it in the pane and click **Remove**.)

g Optionally, check **Remove app from server when finished**—the application will automatically be removed from the repository at the end of your device session.

h Click **Add Application** to complete uploading it to the repository.

- Application that resides online

  a Click **Download from existing URL**.

  b Enter the application URL in the dialog box that appears.

  ![Download from existing URL](image)

  c Click **Download**.

  Your application is listed in the console. Click its name to view application details.
3.4.6.3 Advanced Upload Options for iOS and Android

Advanced options are available when you upload applications for iOS and Android devices. You can opt to sign uploaded iOS applications so you can deliver them non-jailbroken devices. You can also enable iOS and Android applications for object-based scripting.

Select **Add Application**, choose either **Android APK** or **Iphone application Type**, and click **Advanced**.

You will see some or all of the following options (see Figure 3-22 and Figure 3-23 below):

- **Sign Application** — (iOS only) Signs application with Keynote’s certificate and uploads it to the application repository from where you can deliver it to any iOS device (including non-jailbroken devices).

- **Upload As Is** — (Android and iOS) Uploads the application without signing with the Keynote certificate.

  On Android, choose this option if you do not want the application to be enabled for object-based scripting.

  On iOS, choose this option if you do not want the object to be enabled for object-based scripting or be signed with Keynote’s certificate. However, before uploading an iOS application for delivery to a non-jailbroken device, make sure to sign it with your own enterprise certificate or provision to the target UDID and sign with your individual developer certificate.

- **Sign & Enable Application** — (Android and iOS) Signs the application and inserts libraries that enable object-based scripting. For iOS, this enables scripting for native applications as well as testing of web elements in hybrid applications. For Android, this option enables testing of web elements in hybrid applications.
NOTES Object testing of native applications or web elements in hybrid applications on is not available on shared iOS devices in the DAE system.

You can choose to turn off these advanced application upload options off in dedicated systems.

Please contact your Keynote Solutions Consultant for options on enabling an application for object-based scripting if you have an enterprise system or dedicated devices on the shared system.

Figure 3-22 Adding an iOS Application

Figure 3-23 Adding an Android Application
3.4.6.4 Deleting Applications from the Repository

Uploaded applications can be deleted from the repository in two ways:

- To manually delete an application, select it in the Applications tab and then click Remove.
- You can automatically delete an application from the repository at the end of your device session—when adding an application from the file system, check Remove app from server when finished in the New Application dialog box.

3.4.6.5 Delivering an Application to a Device

Once the application has been uploaded to the repository, you can deliver it to the device. The console lists all applications uploaded to the repository by users in your organization.

Applications can be delivered via:

- Data cable—This delivery method automatically installs the application on the device.
- SMS—An SMS message containing a link to the application in the DeviceAnywhere repository is sent to the device. This link is session specific and cannot be reused. In enterprise environments, this application delivery method requires setting up a modem connected to your DeviceAnywhere environment.

Supported delivery methods by smart device platform are:

- Android: Data cable, SMS, or both, depending on the method(s) available to the device
- iPhone: Data cable
- BlackBerry: SMS, Data cable
- Brew MP: Data cable
- Windows Phone 7: Data cable

To deliver an application to the device:

1. Navigate to the Applications tab in the device console of an acquired device.
2. Highlight the application in the console—be sure to select the correct application type for your device.
3. Click the SMS or Data Cable button next to Deliver application via.
4. If you send a link to the application via SMS message, click the link on the device to complete application installation.

   NOTE This link is session specific and cannot be reused.

5. Restart the device if necessary (e.g., when loading applications by data cable onto an iPhone) to complete application installation.

The figure below shows an SMS message containing an application link sent to a device.
Figure 3-24 Application URL Delivered by SMS

The figure below shows an application that has been delivered via data cable to a device. The highlighted icon on the device screen represents the newly installed application.

Figure 3-25 Application Delivery by Data Cable—Android

The image below shows the Applications tab after an application has been delivered to an iPhone device.
3.4.7 Sharing Tab

The **Sharing** tab, accessible by clicking the tools icon of the device console, provides two ways of sharing a device:

- You can generate a share code and email it to invite a user to share your device.
- You can directly share a device with concurrently logged in users from your customer account.

Sharing enables other users to view the screen of shared device(s) that are currently acquired by you. You retain control of the shared device while others view your interaction with it.

The **Sharing** tab also enables you to chat with logged in users you have shared your device with.

### 3.4.7.1 Sharing a Device

To share an acquired device with other users:

1. Select **Share Device** in the **Sharing** tab.
2 In the dialog box that appears, generate a share code or select a concurrently logged in user to share your device.

- To share by generating a share code:
  
  i. Click **Generate Code**. A numerical code that you can email to other users is generated.
  
  ii. Enter the email address of the user you wish to share your device with. You can enter multiple email addresses separated by semicolons.

  ![Share Apple iPhone 3G S](image)

  Click **Send Email**. This sends an email with the share code to the user. The email generated also provides instructions on how to view the device. See Viewing a Shared Device.

- To share by inviting a logged in user:
  
  i. The bottom pane displays the names of concurrently logged in users—check the box next to the user you wish to invite. You can select multiple users.
Click Invite users.

Users invited in this manner see a message in DeviceAnywhere Studio asking if would like to view your shared device. See Viewing a Shared Device.

When your invitation is accepted, users you are sharing your device with are listed in the Sharing tab.

Figure 3-27 Console of Shared Device

To stop sharing a device with other users:

1. Click **Stop Sharing**.

2. Click **Yes** to confirm that you would like to stop sharing.
3.4.7.2 Viewing a Shared Device

There are two ways to accept the invitation to view a shared device.

- If the device was shared using a share code:
  
  a. You receive an email message containing the code and instructions on viewing the device.

  ![Email screenshot]

  b. In DeviceAnywhere Studio, select the Tools menu, then View Shared Device.

  c. In the dialog box that appears, enter the share code and click Send.

- If the invitation was sent directly from DeviceAnywhere Studio, a dialog box pops up to inform you that you can view a shared device. Click Yes to accept the invitation.

![Dialog box screenshot]

When you enter a share code or accept an invitation, you can observe (monitor) a shared device. The shared device appears in a tab in the workspace.
You can stop monitoring a shared device at any point:

- Right-click the device and select **Stop Monitoring**.
- Click **Stop Monitoring** in the **Sharing** tab of the device console.

Click **Yes** in the dialog box that appears to confirm that you wish to stop monitoring the device. The device tab is automatically closed in DeviceAnywhere Studio.
### 3.4.7.3 Sending Messages

Users viewing or sharing a device can exchange chat messages. When a share invitation is accepted, a list of viewers and a message window appears in the **Sharing** tab of the device console. To send a chat message, simply enter text in the message field and click **Send**. The chat pane displays a log of messages exchanged.

*Figure 3-30 Device Sharing with Chat*

### 3.4.8 Cleanup Tab

The **Cleanup** tab contains scripts that can be **Run** to clear history of your device interaction in the device browser, messaging application, or camera.

*Figure 3-31 Cleanup Tab*
3.4.9 Device Log Tab

The Device Log tab, accessible by clicking the “connect device” (smartphone) icon in the device console, provides a control for viewing the device log for software-integrated smart devices. Click Connect to view the device log in a separate window (click Terminate to end the log viewing session).

Figure 3-32 Device Log

You can Pause scrolling in the log window—log information continues to be appended to the bottom of the file, however. You can enter a string to Filter log output. You can Refresh the display or Clear the log window (the log file on the device retains its contents). The contents of the log file on the device are deleted when a device is released.

3.4.10 Network Tab

If your application uses Wi-Fi, you can use this tab to check Wi-Fi connectivity every few seconds by pinging a device—click Connect to begin monitoring Wi-Fi (Wi-Fi should be enabled on your device and it should be connected to a network). This functionality is available on iOS and Android devices and requires the DeviceAnywhere Agent.
Colored status indicators display the strength of the Wi-Fi connection and the most recent downtime.

If the Wi-Fi monitoring feature is unavailable on the device, you see an appropriate message. Click **Terminate** to stop monitoring Wi-Fi connectivity.
3.4.11 Device FTP Tab

The Device FTP tab enables you to view Android, BlackBerry, and iOS file systems with an FTP client, allowing read or write access to the file system (where permitted), as well as access to the device SD card. Select the “connect device” (smartphone) icon in the device console and then select the Device FTP tab.

Click Connect to open an FTP tunnel to your acquired device (click Terminate to terminate the session).
Specific details by mobile platform are listed below:

- Only read access to the file system is available on iOS devices.
- On Android devices, write access to the /sdcard directory and read access to the rest of the file system is available.
- On BlackBerry devices, there is no access to any private information or the /system directory. There is read and write access to unprotected areas of the file system, e.g., the SD card. However, you cannot create/remove directories or rename files/directories.

**NOTE** Contact your Keynote Solutions Consultant to ensure that you have the latest DeviceAnywhere Agent and to have this feature configured for your BlackBerry device.

### 3.4.12 ADB Tunnel Tab

The **ADB Tunnel** tab, accessible by clicking the “connect device” icon in the device console, enables you to open an ADB tunnel to an Android device.

Users with the ADB tool (Android Debug Bridge) on their local machines can execute ADB commands on devices that they have acquired in DeviceAnywhere Studio. Users can access log files, perform file management, check performance, and utilize other ADB commands on an acquired device as if it were locally connected to their own computer.

You can **test latency** to view device performance or follow the instructions to **open an ADB tunnel** to the device.

#### 3.4.12.1 Testing Latency

We recommend checking latency before opening an ADB tunnel to a device; ADB tunneling will not work reliably when there is too much delay in the communication between DeviceAnywhere Studio and the device.

Click **Test Latency**. Once the latency test is complete, the result is displayed in the tab. A measurement of the latency in seconds is displayed next to the result.
Figure 3-38 Latency Test Results

Possible latency test outcomes are:
- Good (green icon): Latency of less than 1 second
- Acceptable (yellow icon): Latency from 1 second to less than 5 seconds
- Poor (orange icon): Latency of 5 seconds or more

3.4.12.2 ADB Tunnel

To open an ADB Tunnel to an Android device:

1. Test latency (recommended).
2. Open a command window (Start > Run in Windows).
3. Navigate to the adb.exe directory.
4. In the command window, type `adb kill-server`.
5. In DeviceAnywhere Studio, click Connect in the ADB Tunnel tab.

The figure below shows an ADB tunnel to a device.
NOTES All commands must be run from the `adb.exe` directory.

You can only open an ADB tunnel to one device at a time.

3.4.13 iPhone Tab

The iPhone tab, accessible by clicking the “connect device” icon in the device console, enables you to delete all applications installed on the device from DeviceAnywhere Studio. This tab is only available for iOS devices.

To delete applications:

1. Click **Remove All**. This deletes all applications loaded onto the device from DeviceAnywhere Studio. The application to be deleted is highlighted on the device screen below.
2 Restart the device for application removal to be completed.

The application icon is no longer on the home screen when the device is restarted. In the image below, the U-verse application icon has been removed from the home screen.

3.5 View and Export Video for Collaboration

DeviceAnywhere Enterprise Interactive supports a frame buffer that captures the device screenshots and video during a live session. From the time a device is acquired, frames are continuously uploaded to the device server. The frame buffer contains information from the last five minutes of activity.

While interacting with a device, you can pause the live video feed to view screens from the buffer. Keynote also allows you to save and export one or more frames as well as device video. You can export frames to the file system or upload them to the DeviceAnywhere Enterprise Portal.

Exported/uploaded frames are a useful tool for team collaboration, enabling you to share device sessions, known issues, and upload images to a bug database.

NOTE Another collaboration tool in DeviceAnywhere Enterprise is device sharing (with chat).
3.5.1 Viewing Video History

The **Show Video History** command in the device menu allows you to view screens from the history of your interaction with the device on the device screen. Right-click an acquired device and select **Show Video History**. This displays a slider below the device enabling you to view frames from the history of your device session.

*Figure 3-40 Device History Slider*

Click on the slider or click **Back** and **Forward** to scroll through video history.

Click **Resume** to resume live video feed. Click **Pause** to pause the live video feed and look at history.

**NOTE** You cannot interact with the device when the live video feed is paused. You will see the following message if you click the touchscreen or keyboard while viewing video history.

3.5.2 Exporting Video History

The **Export Frames** command in the **device menu** gives you four export options, described in the procedures below:

- **Current frame** — Export the current frame to your file system.
- **Frames from history** — Export and save multiple frames to your file system.
- **Video from history** — Generate a video from the frames captured and save it to your file system.
3.5.2.1 Current Frame

You can export the current device frame in JPEG (.jpg) or PNG (.png) format:

1. On the device, navigate to the frame you want to export.
2. Right-click the device and select **Export Frames > Current frame**.
3. In the Save dialog box that appears, specify a name, location, and file type for the exported frame.
4. Click **Save**.

3.5.2.2 Multiple Frames from History

You can select multiple frames from the frame buffer and save them to your file system:

1. Right-click the device and select **Export Frames > Frames from history**.

DeviceAnywhere Studio loads frame history—this can take a few moments.

2. In window that appears, frames are grouped in intervals of one minute each. Select the interval for which you would like to view frames.
3. Select the frames you wish to export and click **Export**. (Use Ctrl-click to select multiple frames; use Shift-click to select a frame range.)

4. In the dialog box that appears, specify a location to export the frames to. PNG files are saved to your file system.

### 3.5.2.3 Video from History

To generate an MPEG video file from selected frames:

1. Right-click the device and select **Export Frames > Video from history**.

DeviceAnywhere Studio loads frame history—this can take a few moments.
2 In window that appears, frames are displayed for time intervals. Optionally, double-click a frame for a time interval to load more frames.

3 Click to select the first frame and then the last frame you want to appear in the video. (To deselect a frame, click the selected frame before it.)

4 Click **Settings** to specify audio settings for export.
You can opt to **Include audio** in the generated video file. (**Do not include audio** is selected by default.) Click **OK** to verify your settings.

**NOTE** Video type and Frame rate are set for MPEG export and cannot be edited.

5 Click **Export** in the video history window.

6 In the dialog box that appears, enter a name for the file and select a location to export the video to. DeviceAnywhere Studio indicates that it is generating the file.

**NOTE** You may generate as many clips as you wish but limit each clip to a minute. If your video file is too large, you will be prompted to select fewer frames or lower the frame rate.

3.5.2.4 Uploading Frames to the DeviceAnywhere Enterprise Portal

You can select multiple frames from the frame buffer and upload them to your account on DeviceAnywhere Enterprise Portal:

1 Right-click the device and select **Export Frames > Upload frames**.

DeviceAnywhere Studio loads frame history—this can take a few moments.
2 In window that appears, select the interval from which you would like to upload frames.

5 Click to select the frames you wish to export. (Use Ctrl-click to select multiple frames; use Shift-click to select a frame range.)

You can double-click a frame to enter a comment.

3 Click Advanced to tag your uploaded frames as a Recording of a successful operation (default) or a Recording of an operation with an error. Click OK.
4 Click **Upload**.

5 Enter a name for the frame set and click **OK**.

6 You are given the option to view uploaded frames directly from Studio. Click **OK** to be directed to the DeviceAnywhere Enterprise Portal. You are automatically logged in to the **Frames** tab in the portal.
You can view and email uploaded frames at any time by logging in to the DeviceAnywhere Enterprise Portal and navigating to the **Frames** tab from the **Administration** link for your environment.

### 3.6 Device Information

To view device information for an acquired device, you can:

- Right-click the device and select **Device Info**, or
- From the menu bar, select **Device > Device Info**.

This opens the Device Information window, which contains tabs for **device-specific features** and **identifying information** for reporting device issues. This information is maintained and updated by Keynote. You will need to use some of the information listed in this window when reporting device issues to Keynote Support.

#### 3.6.1 Features

This tab lists device specifications and carrier information:

- From the menu bar, select **Device > Device Info**.
- **Operating system**, e.g., Android
- **OS Version**, e.g., 2.3.3
- **Screen resolution** in pixels, e.g., 360x480
- **Phone number**
- **Carrier**, e.g., Verizon
- **CPU Name**, e.g., ARM
- **CPU Type**, i.e., single or dual core
- **Onboard Memory** in MB of RAM
- **IMEI/ESN**—International or US device identifier/serial number
- **UDID**—Unique identifier for iOS devices
- **Supported Device Functions**—these are the features available on the device and by which you can [filter devices](#).
3.6.2 DeviceAnywhere Info

This tab displays information used by Keynote to uniquely identify a device. This information must be included in any communication to Keynote when reporting device issues.

- **MCD**—A unique identifier assigned to each device by Keynote
- **Device location**—Geographical location
- **Server**—Server device is connected to
- **ESN (Dec)**—Electronic serial number (decimal)
- **ESN (Hex)**—Electronic serial number (hexadecimal)
- **Integration type**—Type of device control technology used to control device inputs and outputs
- **On Device Agent Version**—version number of the installed DeviceAnywhere Agent
Click **Copy to Clipboard** to copy the device MCD number. This is useful when Reporting an Issue with a device to Keynote Support.

### 3.7 Reporting an Issue

You might need to request a feature or application on a device or report an issue with it. To submit a ticket to Keynote:

1. Right-click a device in the device list or in the workspace and select **Report an Issue**.
2. Device **Details** are automatically displayed in the dialog box that appears. Select an **Issue type**.
3. Optionally, enter a **Description**.
4 Click **Report**. This automatically submits a support ticket to Keynote.

**NOTE** If you are unable to log in to Keynote Support, you may report an issue by calling 1-888-KEY-SYST (539-7978).
4 Test Case Manager Concepts and Workflow

The Test Case Manager module in DeviceAnywhere Studio enables users to create, execute, and manage their mobile tests. Users create and enter test requirements in the Test Case Editor interface and then test against these requirements in the Test Case Runtime interface. DeviceAnywhere Studio tracks the progress of the test execution and saves all test results to the DeviceAnywhere Enterprise Portal.

This chapter introduces you to features, basic concepts, and the workflow in Test Case Manager.

4.1 Test Case Manager Overview

Test Case Manager provides the following functionalities:

- An interface (Test Case Editor) for entering and storing test requirements for mobile application and content testing, including expected results and proofs required
- An execution environment (Test Case Runtime) where users validate their content and/or applications against these test requirements on Keynote’s smart devices
- The ability to capture screenshots and video as proof of test success and for storing in reports
- The ability to track test executions so that testers and managers can easily see the progress and status of various tests across required devices
- A web-based portal where test results are stored and accessible to those with accounts

4.2 Definitions

Before getting started, the definitions below of the basic concepts and test building blocks in Test Case Manager are helpful in using this section of the guide.

Project

A project is an organizational container for test cases and test devices, generally specific to an application or functionality you wish to test. Project metadata also includes permissions and project dependency information.

When you create a project, folders are automatically created in the project directory for test cases and step groups. You can further organize your tests by creating sub-folders. See Projects for information on creating and managing projects.

Test Case

A test case is the end-to-end set of steps/instructions to accomplish a test goal on your mobile application, device, or content. For example, a test case might consist of viewing and deleting call records from a device or searching for directions to a specified address in a mobile web browser.

Test cases are device-independent. They consist of instructions that can be carried out on any project device. Test cases consist of test steps and step groups. Test cases are sub-components of test cycles. See Creating and Managing Test Cases for information on creating, managing, and adding steps/groups to a test case.
Test Step

A test step is a sub-component of a test case or a step group. It includes device-independent instructions, expected results, and the proof required. A test step can reference a step group. See Creating and Managing Test Cases for information on adding test steps to a test case.

Step Group

A step group is a collection of test steps that you can reuse in different test cases within a project. See Creating and Managing Test Cases for information on creating and adding step groups to a test case.

Test Cycle

A test cycle defines your test plan and consists of a group of test cases assigned to be run on all or a subset of project devices. Test cycles allow you to create device-test case groupings to focus testing on particular functional areas or test targets.

As you execute the test cycle, the system shows completion status and automatically store the results in the DeviceAnywhere Enterprise Portal.

4.3 Test Workflow

The best practice test workflow begins with creating a project to contain your tests and test instructions and selecting devices to test. You then define test cases consisting of test steps. Alternatively, create reusable step groups and then create test cases consisting of step groups and/or test steps. After creating instructions, you define your test plan in terms of test cycles. Finally, you run your test cycles and view customized results.

The end-to-end test creation process consists of the following steps:

1. Create a project in the Test Case Manager view and add devices to it.
2. Conceptualize test cases as processes/transactions to accomplish a goal, e.g., search for and purchase an item from an online retailer.
   - Identify test case building blocks:
     - Individual test steps, or
     - Step groups that can be reused in other test cases
3. Begin by creating test cases consisting of test steps.
   - Alternatively, create step groups to accomplish specific tasks within the larger test case objective, e.g., resetting the device, sending a message to the weather service, and verifying response results.
   - Then create test cases consisting of step groups and/or test steps.
4. Create test cycles consisting of subsets of project test cases and devices.
5. Execute and track the progress of test cycles.
5 Projects

A project organizes your test resources, including test cases, step groups, and a device list. You can also configure a project’s visibility to other users.

To manage projects in DeviceAnywhere Studio, select the Test Case Editor interface of Test Case Manager from the sidebar. The project pane, displaying all your projects and associated test assets, is displayed.

Figure 5-1 Test Case Editor Project List

This chapter contains information on creating, opening, and managing projects. It also describes the folders found in the project directory.

5.1 Creating a Project

You need to create a project to organize your test assets before you can begin creating tests.

1 Make one of the following selections in Test Case Editor to create a project:
   • Select New Project from the bottom of the project list.
   • With an open project selected in the project list, select File > New > New Project.
   • Select Project > New Project.
2 Enter a project name in the first screen of the New Project wizard.

3 Click **More Options** to display additional controls.

4 Specify project permissions for other users with the **Editable by** control. You can change this setting later in the **Permissions tab** of the **Project Properties** dialog box.
5  Click **Create** Project.

6  This brings up the Project Properties dialog box where you specify devices, dependencies, and permissions. Click **Save** when done setting properties.

Your project appears in the project list with the folders *manual test cases* and *step groups*—this might take a few moments as the necessary files are prepared. The project is saved to the default location on your local file system:

- Windows XP: `C:\Documents and Settings\<Windows_user_name>\Local Settings\Application Data\DeviceAnywhere\workspaces.<profile_name>\<DAStudio_user_name>\<project_name>`
- Windows Vista and later: `C:\Users\<Windows_user_name>\AppData\Local\DeviceAnywhere\workspaces.<profile_name>\<DAStudio_user_name>\<project_name>`

### 5.2 Project Properties

When creating a project, specify **devices**, **dependencies**, and **permissions** in the Project Properties dialog box. Be sure to **Save** changes to project properties.

**NOTES** To change project properties at any time, right-click the project in the project list > **Properties**.

Users with a license for DAE Automation will also see the **Global Variables** and **Error Types** tabs, which are related to automation scripting. Check the *DAE Automation User Guide* for information.

#### 5.2.1 Overview Tab

View project name and default location on the local file system in the **Overview** tab.

*Figure 5-3 Project Properties – Overview*

#### 5.2.2 Devices Tab

Specify project devices in the **Devices** tab of the Project Properties dialog box.

The **All devices** drop-down list allows you to select a package. You can also **Filter** the device list by any string. The device list is dynamically filtered with each character you type. Filtering by the word “online” displays all online devices.
Select a device from the list below and click **Add** to move it to **Project devices**; click **Remove** to remove it from the list. Use Ctrl-click to select multiple devices in the left pane; use Shift-click to select a device range. Be sure to **Save** changes to project properties.

**NOTE** If you remove a device on which you have executed tests and uploaded results, you will still be able to access the results in the DeviceAnywhere Enterprise Portal.

**Figure 5-4 Add/Remove Project Devices**

To edit project devices at any time, revisit **project properties**.

### 5.2.3 Dependencies Tab

Click the **Dependencies** tab of **project properties** to specify dependent projects. This allows you to reuse the test assets of dependent projects.

**Figure 5-5 Project Properties – Dependencies**
To specify a dependent project:

1. Click **Add Project**.

2. Select a project from the list provided and click **Select**.

   ![Select Project Dialog](image)

   Your dependent project is now listed in the **Dependencies** tab.

3. Be sure to **Save** changes to project properties.

To remove a dependency, select the project name and click **Remove** in the **Dependencies** tab.

### 5.2.4 Permissions Tab

Specify project write permissions for other users in the **Permissions** tab.

**NOTE** You can also specify permissions in the opening screen of the **New Project** wizard.

From the **Editable by** drop-down list, select which users may edit your project. You can give edit permissions to:

- **All users from** `<account_name>`—All users in your account
- **Only me**—Yourself
- **<group_name>**—Users from a specific user group

![Permissions Tab](image)
5.3 Opening a Project

When you log in to DeviceAnywhere Studio, navigate to the Test Case Editor interface and double-click a project from the project list to open it. (The project might take a few moments to be loaded as the version control system synchronizes local project files with those on the DeviceAnywhere Enterprise database.)

This expands the project directory and displays automatically created folders for different types of test assets—test cases and step groups. You may create sub-folders for additional organization as you see fit.

Figure 5-7 Project Directory

- The lock icon near an asset indicates that it is locked for editing by another user.
- The check mark near an asset indicates that it is checked in to the version control system.
- An asset without a check mark indicates that you have checked it out for editing.

5.3.1 Opening Test Assets

You can open test assets by selecting and double-clicking them in the project directory. You can also use the View > Open Resource command to open a dialog box that lists the assets of your open projects. You can filter the list by typing a string in the Select an item to open field. The asset list is dynamically filtered with every keystroke entered into the field. Select an item from the list and click Open.
5.4 Managing Projects

This section describes how to use the powerful project-level search functionality and also describes other project management functions.

5.4.1 Project-Level Search

You can search for any string, including the names of scripts, in a selected project or in all open projects.

1. Right-click your open project in the project list and select Search. This opens up the Search dialog box.

2. Enter a search string in the field provided.

3. Check Case sensitive if you wish to perform a case-sensitive search for the string as entered.

4. Choose a Specific project in which to search or select All open projects.

5. Click Search.

A status bar above the project list displays the outcome of the search and the number of occurrences found of the string, if any.

In the top-right corner of the Test Case Manager interface, the search console icon displays the number of occurrences found.
6 To open up search results in the DeviceAnywhere Scripting Console:
   • Click View Search Results in the status bar.
   • Click the search console icon for search results.

The DeviceAnywhere Scripting Console displays the results of your search. The results of the most recent search persist until the next search.

Figure 5-9 Search Results

Each occurrence is listed with the name and location of the containing script in the local project directory.

Double-click an occurrence to open up the script containing it (the script must not be checked out by another user). You can also select the occurrence and click Open.

If you need to, click Search Again to search for the same string again.

5.4.2 Other Functions

The table below describes the project management commands available from a combination of DeviceAnywhere Studio’s Project menu and right-clicking a project in the project list.

<table>
<thead>
<tr>
<th>Command</th>
<th>Found in</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Project</td>
<td>Project menu</td>
<td>Closes the selected open project.</td>
</tr>
<tr>
<td></td>
<td>Context menu</td>
<td></td>
</tr>
<tr>
<td>Open Project</td>
<td>Project menu</td>
<td>Opens the selected closed project.</td>
</tr>
<tr>
<td></td>
<td>Context menu</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Found in</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Publish Project</td>
<td>Project menu</td>
<td>Publishes a project. You will be asked to check in any checked out scripts before they can be published.</td>
</tr>
<tr>
<td>Export Project</td>
<td>Project menu</td>
<td>Exports project as a ZIP file to a user-specified location—only available for open projects.</td>
</tr>
<tr>
<td>Check In All</td>
<td>Project menu</td>
<td>Checks in all checked out test assets—only available for open projects.</td>
</tr>
<tr>
<td>Search</td>
<td>Project menu</td>
<td>Searches for a string in the current project or all open projects.</td>
</tr>
<tr>
<td>Remove Project</td>
<td>Project menu</td>
<td>Removes project files.</td>
</tr>
<tr>
<td>Properties</td>
<td>Project menu</td>
<td>Brings up the Project Properties dialog box of the selected open project.</td>
</tr>
<tr>
<td>New Project</td>
<td>Project menu</td>
<td>Creates a new project.</td>
</tr>
</tbody>
</table>

Keynote Confidential
<table>
<thead>
<tr>
<th>Command</th>
<th>Found in</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import Project</strong></td>
<td><strong>Project menu</strong></td>
<td>Imports an archived project ZIP file to create a project. Click <strong>Browse</strong> to select a project and click <strong>Next</strong>. Specify a name, version control, and permissions for the imported project, as you would for a new project.</td>
</tr>
<tr>
<td><strong>Refresh Projects</strong></td>
<td><strong>Project menu</strong></td>
<td>Refreshes the project list so you can see projects that have been created after you have logged in.</td>
</tr>
</tbody>
</table>
6 Creating and Managing Test Cases

After creating a project to contain your test assets, you can create test cases in the Test Case Editor interface of Test Case Manager.

A test case is the basic unit of testing in DeviceAnywhere Enterprise Interactive and is the end-to-end process that accomplishes a specific goal in order to test an application use case. For example, a test case might consist of viewing and deleting call records from a device.

The larger test case goal is composed of discrete procedures, or test steps. You can also create a collection of test steps called a step group, which can be referenced in a test case. Step groups can be reused in different test cases within a project. Test cases, in turn, are the building blocks of test cycles.

Test cases are device-independent. A test case script is defined so that it can be executed on any project device.

This chapter contains step-by-step instructions for creating and managing test cases in Test Case Manager.

6.1 Creating a Manual Test Case

To create a new test case in Test Case Editor:

1 Select a project and double-click to load it.
2 Expand the project directory and select the manual test cases folder.
3 Right-click the folder and select New Test Case.
4 Enter a name for the test case in the dialog box that appears and click Create.

![New Test Case dialog box](image)

The new test case is opened in a tab in the workspace. The test case is blank and its icon indicates that it is checked out of version control. A list of project devices is displayed in the right-most pane.

![DeskAnywhere Enterprise Studio](image)

5 Optionally, select and interact with a project device to assist with defining test steps:
   a Select a device from the list of project devices in the right pane.
   b Click Save Selected above the device list. The device is loaded in the workspace next to the test script.
   c If it isn’t already, acquire the device:
      · Click Acquire Device on the on-screen notification.
      · Right-click the device and select Acquire Device.

**NOTE** You can click Change Device to return to the project device list and select another device.

6 To populate the test case, you must add test steps and/or create and reference step groups.
7 When done editing, check the test case in to version control.
6.1.1 Test Steps

Test steps are step-by-step instructions for manual testers to follow. Test step instructions also include expected results and proofs required. Test steps are integral to the test case in which they are created and cannot be reused in other test cases. However, step groups containing test steps can be reused across project test cases. This section deals with how to add and manage test steps.

6.1.1.1 Adding Test Steps

To insert a test step into a test case or step group:

1. Ensure that the test case or step group is open and checked out for editing.

2. Click Add step at the top-left of the test case tab. This displays editable fields for test step properties.

3. Complete test step properties as follows:
   - Name—Change the default name of the test step.
   - Instructions—Enter information that tells the tester what interactions to perform on the device.
   - Proof type—Select the type of evidence to be collected for the test step (be sure to specify the exact point at which proof must be collected). Proofs are typically collected for executed actions that result in visible changes on the device screen. For example, if an incoming message generates a notification, the proof required could be a screenshot of the notification. The options in the Proof type drop-down list are:
• None required — No proof needs to be captured for the step.
• Single picture — A single screenshot of the device screen
• Multiple pictures — Multiple screenshots of the device screen
• Video — Video film of the device screen
• Expected — Enter the expected result of executing the test step.
• Constraints — Check the box when the step is optional. Enter an explanation of the circumstances for considering the step optional in the field provided.
• Automation — Optionally, select the ellipsis button to associate an automated action with the test step. This is covered in the DAE Automation User Guide.

4 Repeat steps 2 – 3 above to add other test steps.

The figure below shows a completed test step.

Figure 6-2 Test Step Instructions

6.1.1.2 Managing Test Steps

Once steps have been added, they can be rearranged in any desired order or deleted:

1 In a test case or step group, highlight the step to be moved. Step details are displayed to the right.
2 To reorder the step, click the up or down arrow at the bottom of the script pane.

To delete the step, click Remove at the bottom of the pane.

Figure 6-3 Controls for Managing Test Steps
6.1.2 Step Groups
Step groups, collections of steps, help expedite the building of test plans as they can be reused across different test cases.

6.1.2.1 Creating a Step Group
To add a new step group:

1. Expand the project directory.
2. Right-click the step groups folder and select New Step Group.
3. Enter the step group name and click Create.

The new step group is opened in a tab in the workspace. The step group is blank and its icon indicates that it is checked out of version control. A list of project devices is displayed to the right.

4. Add test steps as described in the section above.
5. Check the step group in when done adding test steps.

The figure below shows a completed step group, which can be inserted into a test case. Step groups can be reused across multiple project test cases.
6.1.2.2 Inserting a Step Group into a Test Case

Once you have created your step group, you can insert it into a test case:

1. Ensure that the test case or step group is open and checked out for editing.
2. Click Add group at the top-left of the test case tab. This displays a dialog box from which you can select project step groups.
3. Click the step group you wish to add. Details are displayed in the right pane.
4 Click **Select**. The step group is added to the test case. The figure below shows a step group “group2” that has been added to a test case “cinquo.”

5 Configure optional properties of the added step group:
   - **This step is optional when**—Check and fill out the field below to specify the conditions under which the step group is optional. If this option is selected, the user can opt not to execute the group.
   - **This step group is a loop**—Check if the step group is to be looped. Provide instructions in the field below on the number of loops and/or conditions for exiting the loop.

6 **Check the test case in** when done editing.

**NOTE** You can insert a step group into another step group.
6.2 Managing Test Assets

This section contains information on how to manage your test assets (test cases and step groups), including setting properties, opening and checking out scripts for editing, checking in and closing scripts, rolling back scripts to earlier versions, deleting scripts, searching for references, and other functions.

6.2.1 Properties Dialog Box

The properties dialog box for test cases and step groups displays metadata and in the case of test cases, allows you to enter a description.

To open the properties dialog box, right-click the test asset in the project directory and click Properties. Be sure to Save any changes to action properties.

The Overview tab contains non-editable fields for the script’s Name and Location within the project directory in the local file system, the date Last modified, and whether checked in or out of Version control. The Last modified field is updated when the script is checked in or out, and in the case of test cases, also when properties are edited and saved.

The Description tab in test case properties allows you to enter a description.

Click Cancel or Save to close the dialog box.

Figure 6-5 Properties—Overview
6.2.2 Opening a Script for Editing

This section describes how to open and check out a script for editing.

1. Open a test asset:
   - Select and double-click the asset in the project directory.
   - Select the asset in the project directory, right-click, and select **Open**.

   This will open a tab for the test case or step group in the workspace. (See also Opening a Project.)

   You may open multiple test assets. The workspace displays tabs for each open asset and lists the number of open tabs. Use the drop-down list next to this number to tab through your assets.

2. Check out the script from the version control system for editing:
   - Click **Check Out** in the workspace to check out the open test case or step group.
   - Right-click the asset in the project directory and select **Check Out**.

6.2.3 Checking In and Closing Scripts

This section describes how to close and check in a script when done scripting.

1. Check the test asset in:
   - Click **Check In** above the script canvas to check in the open script.
   - Right-click the asset in the project directory and select **Check In**.

   This grays out the workspace and displays the **Check Out** button.
2 Close the script:
   • Click the close button in the tab.
   • Right-click the tab and from the drop-down list that appears, select **Close** to close the active script, **Close All** to close all open tabs, or **Close Others** to close other open tabs.

**NOTE** Be sure to release any acquired devices if you are no longer using them.

### 6.2.4 Rolling Back Scripts

The version control system tracks and saves incremental changes to scripts when they are checked in, enabling you to roll back a script to an earlier version. A script must be checked out to be rolled back.

**CAUTION** Rolling back a script cannot be undone. Any changes not checked in are replaced by contents of the earlier version.

To roll back a script:

1 Right-click your script to display the device menu.

2 Choose a method to roll back your script:
   • To roll back to the most recently checked in version:
     i Select **Replace With Last Checked In**.
ii Click **Replace** in the dialog box that appears.

This displays the earlier script version in the workspace and updates the script version number (right-click > **Show History** to see the revision history dialog box.)

- To select the script version you wish to roll back to:
  i Select **Show History**.

  This opens up a revision history dialog box where script versions are listed by revision number, date checked in, author, and comments.

  ![Revision History Dialog Box](image)

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Revision Time</th>
<th>Author</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Today, 01:47 PM</td>
<td>user user</td>
<td>[Initial version]</td>
</tr>
<tr>
<td>2</td>
<td>Today, 01:48 PM</td>
<td>user user</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Today, 01:49 PM</td>
<td>user user</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Today, 02:04 PM</td>
<td>user user</td>
<td>[current]</td>
</tr>
</tbody>
</table>

  **NOTE** If the script is checked out, the most recent version is listed as **Current** with the time checked out—it has no revision number. The revision number and time are updated when the script is checked back in.

  ii Select the script version you would like to roll back to and click **Roll back**.

  iii Click **Roll back** to confirm your selection.

  ![Confirm Rollback Dialog Box](image)

  This displays the earlier script version in the workspace.

3 Be sure to check the script back in to save changes.
6.2.5 Removing Scripts

You can remove test cases and step groups:

1. Right-click the script in the project directory and select **Remove**.
2. Click **Remove** in the dialog box that appears to confirm your selection.

Removing script clears it from the project directory. However, you can recover it by creating a new script with the same name. You can access and restore the script to older versions in the **Show History** dialog box.

In the version history dialog box for a script below, the removed version is marked as **Deleted**. The new version is marked as **Current**. You can roll the script back to earlier versions before the script was removed.

*Figure 6-7 Recovering a Deleted Script from Earlier Versions*

6.2.6 Searching for References

You can find all other scripts that make a reference (call) to a selected script.

1. Right-click your script in the project directory and select **Find References**.

   A status bar above the project list displays the outcome of the search and the number of references found, if any.

   *Figure 9-1 Find References dialog box*
In the top-right corner of the Test Case Manager interface, the search console icon displays the number of references found.

2

To open up a list of references in the Scripting Console Window (see Figure 6-8 below):

- Click View Search Results in the status bar.
- Click the search console icon.

The DeviceAnywhere Scripting Console window displays the results of your search. The results of the most recent search persist until the next search.

Each reference is listed by name of script and its location in the local project directory.

![Figure 6-8 References Found](image)

Double-click a reference to open up the script containing it (the script must not be checked out by another user). You can also select the reference and click Open.

6.2.7 Other Functions

The table below describes other management commands available by right-clicking script in the project directory:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Comment</td>
<td>Allows you to add notes (script must be checked out):</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Add Comment dialog box" /></td>
</tr>
<tr>
<td></td>
<td>Notes are displayed in the Comments column of the revision history dialog box. Right-click the script and select Edit Comment to change a note before checking the script back in.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy “&lt;script&gt;”</td>
<td>Copies a script for pasting at another location. A test case can only be pasted in a manual test cases folder or sub-folder. A step group can only be pasted in a step groups folder or sub-folder.</td>
</tr>
<tr>
<td>Cut “&lt;script&gt;”</td>
<td>Cuts a script for pasting at another location. A test case can only be pasted in a manual test cases folder or sub-folder. A step group can only be pasted in a step groups folder or sub-folder.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes a script at the selected location. A test case can only be pasted in a manual test cases folder or sub-folder. A step group can only be pasted in a step groups folder or sub-folder.</td>
</tr>
<tr>
<td>Paste with Dependencies</td>
<td>Pastes copied script along with any other scripts (e.g., step groups) that it references. Test cases must be pasted in the destination project’s manual test cases folder, and step groups in the step groups folder.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to specify a new name for the asset.</td>
</tr>
</tbody>
</table>
7 Creating and Executing Test Cycles

To execute tests in Test Center Enterprise, you must create test cycles that consist of a group of project test cases selected to run on all or a subset of project devices. Test cycles are created and executed in the Test Case Runtime interface of Test Case Manager.

Figure 4-18 Test Case Runtime

A test cycle represents a test plan for the test cases and devices in a project. A test cycle contains a subset of project test cases specified to be executed on a subset of project devices—test cycles allow you to create device-test case groupings to focus testing on particular functional areas or test targets.

This chapter contains step-by-step instructions for creating and executing test cycles.

7.1 Creating a Test Cycle

NOTE Once created, a test cycle cannot be edited or deleted.

To create a test cycle in Test Case Runtime:

1. Select the Project you wish to create the test cycle in from the drop-down menu provided.
2 Click on the **New test cycle** hyperlink.

3 In the first screen of the New Test cycle wizard that appears, specify the following:

   - **Name**
   - **Description**

4 Click **Next** to move the next screen of the New Test Cycle wizard. (This button is grayed out if your new test cycle does not have a unique name.)

5 Select test cases. The **Project test cases** pane displays the test cases from your project that can be added to the test cycle. Click **Add** to move a selected test case to the **Selected test cases** pane; click **Remove** to remove it from the pane.

   Use Ctrl-click to select multiple test cases in the left pane; use Shift-click to select a range of test cases. Use the arrow buttons to reorder selected test cases.
6 Click **Next** to move to the next wizard screen. (Click **Back** to return to the previous screen.)

7 Select devices. The **Project devices** pane displays devices from your project that can be added to the test cycle. Click **Add** to move a selected device to the **Selected devices** pane; click **Remove** to remove it from the pane.

Use Ctrl-click to select multiple devices in the left pane; use Shift-click to select a range of devices.

Use the free-form **Filter** to search for devices. The device list is dynamically filtered with each character you type. Filtering by the word “online” displays all online devices.

8 Click **Finish** to finish configuring your new test cycle and exit the wizard.

The test cycle is displayed in Test Case Runtime with controls that enable you to **execute** it.
7.2 Executing a Test Cycle

Once you have created your test cycle, you can select a device and begin execution in the Test Case Runtime interface.

7.2.1 Selecting a Device and Test Case

Begin test cycle execution by selecting a project, device, and test case:

1. If you need to, select the **Project** from the drop-down menu provided.
2. Select a device and click **Run Test Cycle**.
The workspace displays a list of test cases in the test cycle and automatically acquires and loads the device (see Figure 7-1 below).

**NOTE** At any point after you begin test cycle execution, you can return to the previous screen by clicking the Back button in the top-left corner of the workspace.

3 Select a test case. The test cycle is executed one test case at a time on a chosen device.

4 Optionally, click the More drop-down list to:

- Mark a test case as inapplicable (Mark ‘Not Applicable’)
  
  i Enter a note in the box provided and click Mark N/A.

  ii A status bar above the test case list shows that the test case is marked as complete. Select another test case from the list or click Next test case to continue with test cycle execution.
• Add a note (Add Note)

Enter a note and click Save Note.

5 If you haven’t been automatically advanced to the next test case, click Run Test Case.

Figure 7-1 Selecting a Test Case to Execute

7.2.2 Executing Test Case Steps

For each test case, test steps with detailed instructions, expected results, and proofs required are displayed. To execute a test step, you can interact with the device touchscreen and/or keyboard as well as use the device console. Workspace controls enable you to mark a step as passed/failed, capture proofs, clear proofs, mark a step as inapplicable, and append notes.

NOTE Test steps must be executed in the order they appear. If a step is incomplete, instructions of subsequent steps are grayed out.
To execute a test step:

1. Select the first test step in the list displayed. The selected step is highlighted in blue.

2. Refer to the Instructions and Expected Results to interact with the device and execute the step. If instructions are grayed out, select and complete the previous step.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Expected Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the Home button to start from the device home screen</td>
<td>Home screen</td>
</tr>
</tbody>
</table>

You can interact with the device touchscreen and keyboard as well as use the device console to carry out step instructions.
3 In the **Proof** area, click the controls provided to capture proof; click **Clear** to delete the proof captured.

- Single picture—Click **Take picture**.

**Proof (single picture):**

![Single picture example]

- Multiple pictures—Select **Picture 1** or **New picture** from the drop-down list provided (pictures are automatically numbered) and click **Take picture**.

**Proof (multiple pictures):**

![Multiple pictures example]

- Video—When you are ready to capture device interaction, click **Record**.

**Proof (video):**

![Video example]
The proof pane displays the video being captured as you interact with the device. Click Stop when done.

Click the play button to review video captured

6 Optionally, click the More drop-down list to:
   • Mark the test step as inapplicable (Mark ‘Not Applicable’) — Enter a note in the box provided and click Mark N/A. The next test step in the list is automatically selected for you to execute.
   • Add a note (Add Note) — Enter a note, e.g., reason for failing a step, and click Save Note.
7. If you haven't been automatically advanced to the next test step, \textbf{Pass} or \textbf{Fail} the step. You are automatically advanced to the next step.

8. \textbf{Advance through the test cycle} to complete the test case and then choose another test case, or if all test cases for a device are complete, to choose another device.

9. Results are uploaded at the completion of a test case on a device. You can \textcolor{red}{view results} at the completion of each test case or at the end of test cycle execution.

\subsection*{7.2.3 Advancing through Test Cycle Execution}

DeviceAnywhere Studio keeps track of test cycle execution to display completion status at all times at the top-right corner of the application window. A yellow icon indicates that execution is underway, while a green icon indicates that execution is complete.

\textit{Figure 7-3 Test Cycle Status}

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{test_cycle_status.png}
\caption{Test Cycle Status}
\end{figure}

At any point after you begin test cycle execution, you can return to the previous screen by clicking the \textcolor{red}{Back} button in the top-left corner of the workspace.

\textit{Figure 7-4 Stopping Test Cycle Execution}

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{stop_test_cycle.png}
\caption{Stopping Test Cycle Execution}
\end{figure}

You can also switch the device you are testing by right-clicking the device and selecting \textbf{Choose different device}. If asked, click \textbf{Release} to release the current device. You are returned to the \textcolor{red}{test cycle start page} to select another device.

You can easily resume testing from where you left off by advancing through test cycle execution screens. When you have completed executing a test case on a device, a status bar above the workspace displays a link to execute the next test case. You can also back up to the \textcolor{red}{test case selection} screen to begin executing a new test case.
You can view results after test case execution has been completed on a device. When you have completed all test cases on a device, a status bar above the workspace displays a link to select the next device. You can also back up to the test cycle start page to select another device.

You are prompted to release the current device if you haven't already.

On the test case start page, the device is marked with a green icon to indicate that testing is complete.

When you have completed executing the entire test cycle, the status bar displays the following message when results are ready to be viewed.
Figure 7-9 Completed Test Cycle Notification

Click the View Results link in the status bar or click the corresponding button above to view results.

When you Back up to the test cycle start page, all devices are marked complete. Select a device and click Review Test Cycle to navigate through test cycle execution screens.

Figure 7-10 Completed Test Cycle (All Devices)
8 Viewing Results

Test results are uploaded to the DeviceAnywhere Enterprise Portal from DeviceAnywhere Studio one test case at a time as you execute a test cycle.

Results can be viewed from DeviceAnywhere Studio or by logging in to the DeviceAnywhere Enterprise Portal directly.

8.1 Viewing Results from DeviceAnywhere Studio

As long as you have completed the execution of an entire test case on a test cycle device, you will see a View Results button that appears at the top of test cycle execution pages.

Figure 8-1 Viewing Results from DeviceAnywhere Studio

Click this button to access results that have been uploaded so far to the web portal. This takes you to the overview of test cycle results in the DeviceAnywhere Enterprise Portal for the selected test case on the selected device (or the first test case on the first device, if you haven’t made a selection).

8.2 Viewing Results Directly in the Portal

You can log in to the DeviceAnywhere Enterprise Portal at any time to view previously uploaded results for script runs from the Test Case Runtime interface.

This section covers navigating to test results in the DeviceAnywhere Enterprise Portal, interpreting an overview of test cycle results, and viewing detailed results for a test case on a selected device.
8.2.1 Navigating to Results

To navigate to test results in the DeviceAnywhere Enterprise Portal:


2. Select the link for your test environment under My Environments in the left pane.

3. Click View Test Result in the right pane.

   NOTE You can also select the Administration link, and then Test Results in the Getting Around section.

4. Select the Manual Test Results tab if you are not automatically directed there.

5. From the drop-down list provided, select a project for which you wish to view results.
Uploaded test cycle results are listed for the project. For each test cycle, the number of test cases that are **Not Started**, **In Progress**, or **Failed/Passed** is listed.

<table>
<thead>
<tr>
<th>Test Cycle</th>
<th>Created At</th>
<th>Not Started</th>
<th>In Progress</th>
<th>Failed</th>
<th>Passed</th>
<th>Review</th>
<th>Archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle1</td>
<td>06/04/2013 11:16:42 AM</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Review</td>
<td>Archive</td>
</tr>
<tr>
<td>Cycle2</td>
<td>06/04/2013 11:30:58 AM</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Review</td>
<td>Archive</td>
</tr>
<tr>
<td>TwoTestCase</td>
<td>06/04/2013 11:38:45 AM</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Review</td>
<td>Archive</td>
</tr>
</tbody>
</table>

6. Click **Review** next to a test cycle to get an overview of test cycle results and then view detailed results.

### 8.2.2 Overview of Test Cycle Results

After navigating to the test cycle you wish to view results for, you can opt to **Review** or **Archive** results. Click **Archive** to hide a test cycle from the results list. Click **Show Archived Results** to display a list of archived test cycle results (see Figure 8-2 below). (You can **Hide Archived Results** as well as **Un-Archive** a test cycle result at any time.)

**Figure 8-2 Archived Test Cycle Results**

Select the test cycle for which you want to **Review** results. Results for the test cycle are listed by test case and device. Figure 8-3 shows the test case-device matrix for a test cycle with two test cases on two devices. Figure 8-4 shows the for a test cycles with a single test case on two devices.

**Figure 8-3 Test Cycle: Test Case – Device Matrix Example 1**
Successful test case runs are listed with a green icon, unsuccessful runs with a red icon, and incomplete (stopped) runs with a yellow icon. Test cases that have not been executed or are marked “not applicable” are listed with a clear icon.

Click **Export to Excel** to export overview of test cycle results in the test case – device matrix to a spreadsheet.

### Table 8-1 Exported Overview of Test Cycle Results

<table>
<thead>
<tr>
<th>Device Name</th>
<th>TC2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPhone 4G Search</td>
<td>View</td>
</tr>
<tr>
<td>Galaxy Nexus 4</td>
<td>View</td>
</tr>
</tbody>
</table>

8.2.3 Viewing Detailed Results

Click **View** next to a device in the test case – device matrix to view the results page of the most recent test case run. Detailed results consist of command-by-command results with device screenshots.

Test steps, including steps in step groups, are displayed on the left in a tree-like structure. Select a step on the left to view results for it in the right pane. You can download image proofs in PNG format.

Figure 8-5 below shows the overall results of a test case on a device. The test case name is selected in the left pane while overall test case results are shown in the right pane.
The tree structure displays test steps and step groups in the test case. A yellow icon indicates a step group. A green check mark next to a node indicates that a test or test step passed, while a red icon indicates failure. No icon indicates a step marked as inapplicable.

Figure 8-6 Detailed Test Results—Tree Structure

Figure 8-7 on the page below shows detailed results for a successful test case step, complete with uploaded video.
Figure 8-7 Successful Results for a Step with Video Proof

You can store proof images to disk by clicking **Download Original**. Click an image to view a larger version of it.

Figure 8-8 Enlarged Proof Image
For a failed test case, the overall results and the step at which the test case failed are highlighted in red.

*Figure 8-9 Failed Test Case Results*

Click **Export** at the top left of the page to save results as a PDF file. You can opt to save the currently displayed page (**This page only**) or results for all steps in the test case (**All pages**).

*Figure 8-10 Exporting Test Results from the Portal*

Click **Email Results** at the top left to email a link to the current results page. You can **Select Recipients** from users in your account or enter a **Custom Email** address as well as mark a copy to yourself. Enter a **Custom Message** in the field provided and click **Send**.
Figure 8-11 Emailing Test Results from the Portal